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Have	you	ever	been	knee-deep	in	a	dataset,	trying	to	make	sense	of	the	numbers,	only	to	find	yourself	lost	in	a	sea	of	data?	If	you’re	nodding	along,	you’re	not	alone.	Analyzing	data	can	feel	overwhelming,	but	breaking	it	down	into	meaningful	parts	can	make	all	the	difference.	Enter	the	world	of	quartiles.	Today,	we’re	focusing	on	how	to	calculate	the
first	(Q1)	and	third	quartile	(Q3)	in	Excel,	two	essential	metrics	for	understanding	your	data’s	distribution.	In	this	article,	we’ll	walk	through	everything	you	need	to	know	about	finding	Q1	and	Q3	in	Excel.	We’ll	start	with	a	quick	primer	on	what	quartiles	are	and	why	they	matter.	Then,	we’ll	get	into	the	nitty-gritty—step-by-step	instructions	on
calculating	these	quartiles	and	using	them	to	analyze	your	data	effectively.	By	the	end,	you’ll	be	ready	to	tackle	your	spreadsheets	with	newfound	confidence.	Understanding	Quartiles	and	Their	Importance	Before	we	jump	into	Excel,	let’s	take	a	moment	to	understand	what	quartiles	are	and	why	they’re	important.	Quartiles	divide	your	data	into	four
equal	parts,	giving	you	a	clearer	picture	of	its	distribution.	Imagine	you	have	a	list	of	exam	scores	from	your	class.	Quartiles	can	tell	you	how	scores	are	spread	out,	where	most	students	fall,	and	identify	any	outliers.	The	first	quartile,	or	Q1,	represents	the	25th	percentile.	This	means	25%	of	your	data	falls	below	this	point.	On	the	flip	side,	the	third
quartile,	or	Q3,	is	the	75th	percentile,	indicating	that	75%	of	your	data	is	below	this	point.	The	range	between	Q1	and	Q3	is	known	as	the	interquartile	range	(IQR),	which	helps	you	understand	the	spread	of	the	middle	50%	of	your	data.	Why	are	these	numbers	important?	They	help	you	understand	the	center	and	spread	of	your	data,	highlight	trends,
and	detect	any	anomalies.	With	quartiles,	you	can	make	more	informed	decisions	based	on	data	insights	rather	than	just	averages.	Setting	Up	Your	Excel	Sheet	Alright,	let’s	roll	up	our	sleeves	and	dive	into	Excel.	First	things	first,	you	need	a	dataset.	Open	Excel	and	enter	your	data	into	a	single	column.	If	you	have	a	more	extensive	dataset,	you	might
want	to	label	your	columns	for	clarity.	Let’s	say	you’re	working	with	a	list	of	sales	figures	over	a	month.	Enter	these	numbers	into	column	A,	starting	from	A2,	with	a	column	header	in	A1	(e.g.,	“Sales	Figures”).	Once	your	data	is	entered,	it’s	always	a	good	idea	to	double-check	for	any	errors	or	missing	values.	This	ensures	your	calculations	are
accurate.	If	your	dataset	is	enormous,	you	can	use	Excel’s	built-in	tools	to	help	clean	up	your	data.	For	instance,	“Remove	Duplicates”	in	the	Data	tab	can	be	a	lifesaver	if	you	accidentally	entered	some	figures	twice.	Now	that	your	data	is	ready,	let’s	move	on	to	calculating	those	quartiles.	Calculating	Q1	Using	the	QUARTILE	Function	Excel	makes	it
super	easy	to	calculate	quartiles	with	the	built-in	QUARTILE	function.	Here’s	how	to	find	Q1:	Click	on	the	cell	where	you	want	to	display	the	Q1	result.	Let’s	say	it’s	B2.	Enter	the	formula:	=QUARTILE(A2:A101,	1)Replace	A2:A101	with	the	range	of	your	dataset.	The	“1”	in	the	formula	specifies	that	you	want	the	first	quartile.	Press	Enter,	and	voila!
You	should	see	the	Q1	value	appear	in	the	cell.	Using	the	QUARTILE	function	is	efficient	and	straightforward,	but	it’s	not	the	only	method	available.	If	you’re	curious,	Excel	offers	several	other	functions	for	quartile	calculations,	which	we’ll	get	into	later.	Calculating	Q3	Using	the	QUARTILE	Function	Now	that	you’ve	nailed	down	Q1,	let’s	move	on	to
Q3.	The	process	is	pretty	much	identical,	with	one	small	tweak:	Select	the	cell	where	you	want	the	Q3	result	to	be	displayed.	Let’s	choose	B3.	Enter	the	formula:	=QUARTILE(A2:A101,	3)Again,	make	sure	to	use	your	dataset	range.	The	“3”	indicates	you’re	looking	for	the	third	quartile.	Hit	Enter,	and	there	you	have	it!	The	Q3	value	should	now	be
visible	in	the	cell.	With	Q1	and	Q3	calculated,	you’re	well	on	your	way	to	understanding	your	data’s	spread.	But	Excel	offers	more	than	one	way	to	skin	a	cat,	so	let’s	explore	some	alternate	methods.	Using	the	QUARTILE.EXC	and	QUARTILE.INC	Functions	Excel	offers	two	more	functions	for	calculating	quartiles:	QUARTILE.EXC	and	QUARTILE.INC.
They’re	quite	similar	to	the	QUARTILE	function	but	differ	slightly	in	how	they	handle	data	points.	QUARTILE.INC:	This	function	includes	the	minimum	and	maximum	values	of	your	dataset	when	calculating	quartiles.	It’s	essentially	the	same	as	the	QUARTILE	function.	Here’s	how	to	use	it	for	Q1	and	Q3:	=QUARTILE.INC(A2:A101,	1)	//	For	Q1
=QUARTILE.INC(A2:A101,	3)	//	For	Q3	QUARTILE.EXC:	This	function	excludes	the	minimum	and	maximum	values,	providing	a	slightly	different	quartile	calculation.	It	can	be	useful	when	you’re	looking	for	a	more	conservative	estimate	that	ignores	potential	outliers:	=QUARTILE.EXC(A2:A101,	1)	//	For	Q1	=QUARTILE.EXC(A2:A101,	3)	//	For	Q3
Choosing	between	these	functions	depends	on	your	dataset	and	how	you	want	to	interpret	your	data.	It’s	always	a	good	idea	to	understand	the	underlying	assumptions	before	deciding	which	function	to	use.	Understanding	and	Using	the	Interquartile	Range	(IQR)	Now	that	you	have	Q1	and	Q3,	you’re	ready	to	calculate	the	Interquartile	Range	(IQR).
The	IQR	is	a	measure	of	variability,	showing	you	the	range	within	which	the	central	50%	of	your	data	lies.	It’s	particularly	useful	for	identifying	outliers.	To	calculate	the	IQR,	simply	subtract	Q1	from	Q3:	=Q3	-	Q1	If	you’ve	placed	your	Q1	in	B2	and	your	Q3	in	B3,	your	IQR	formula	in	B4	would	look	like	this:	=B3	-	B2	The	IQR	helps	you	understand	the
spread	of	your	data’s	middle	portion.	It’s	an	excellent	tool	for	spotting	outliers,	as	values	significantly	outside	of	this	range	could	be	considered	anomalies.	Practical	Applications	of	Quartiles	and	IQR	Understanding	quartiles	and	the	IQR	can	transform	how	you	interpret	data.	For	instance,	imagine	you’re	analyzing	customer	satisfaction	survey	results.
By	calculating	the	quartiles,	you	can	identify	how	most	customers	feel	and	pinpoint	any	extreme	feedback.	Here	are	a	few	practical	applications:	Identifying	Outliers:	Use	the	IQR	to	find	data	points	that	fall	well	outside	the	typical	range.	For	example,	if	you’re	looking	at	monthly	sales	figures,	identifying	these	outliers	can	help	you	understand	what
went	exceptionally	well	(or	poorly).	Comparing	Datasets:	Quartiles	allow	you	to	compare	different	datasets	easily.	If	you’re	looking	at	sales	figures	from	two	different	months,	quartiles	can	show	you	if	one	month	had	more	variability	than	the	other.	Setting	Benchmarks:	Quartiles	are	useful	for	setting	realistic	benchmarks.	If	you’re	working	in	sales,
knowing	the	upper	quartile	can	help	set	targets	that	are	ambitious	yet	achievable.	By	integrating	quartiles	into	your	data	analysis	toolkit,	you	can	make	more	informed	decisions	and	derive	deeper	insights	from	your	data.	Common	Mistakes	and	How	to	Avoid	Them	While	calculating	quartiles	in	Excel	is	straightforward,	it’s	easy	to	make	mistakes	that
can	lead	to	incorrect	results.	Let’s	look	at	some	common	pitfalls	and	how	to	avoid	them:	Incorrect	Data	Range:	Double-check	that	your	data	range	in	the	formula	matches	your	dataset.	Misplacing	a	column	or	row	can	throw	off	your	calculations.	Missing	Data:	Ensure	there	are	no	blanks	in	your	dataset.	Excel	might	ignore	these,	leading	to	skewed
quartiles.	Misunderstanding	the	Function:	Be	aware	of	the	differences	between	QUARTILE,	QUARTILE.INC,	and	QUARTILE.EXC,	and	choose	the	right	one	based	on	your	needs.	By	being	mindful	of	these	potential	errors,	you	can	ensure	your	quartile	calculations	are	accurate	and	reliable.	Going	Beyond:	Visualizing	Quartiles	and	IQR	Numbers	are
great,	but	visuals	can	often	make	data	insights	more	accessible.	Excel	offers	various	ways	to	visualize	quartiles	and	IQR,	making	it	easier	to	interpret	your	data.	One	popular	method	is	using	a	box	plot,	also	known	as	a	whisker	plot.	Box	plots	provide	a	visual	summary	of	data,	showing	the	median,	quartiles,	and	potential	outliers	all	in	one	chart.
Although	Excel	doesn’t	have	a	direct	box	plot	chart	type,	you	can	create	one	using	the	“Insert”	tab	and	selecting	“Insert	Statistic	Chart.”	Here’s	a	quick	guide	to	creating	a	box	plot:	Select	your	dataset.	Go	to	the	“Insert”	tab	in	the	ribbon.	Click	on	“Insert	Statistic	Chart”	and	choose	“Box	and	Whisker.”	Customize	your	chart	using	the	“Chart	Tools”
that	appear,	adjusting	colors,	labels,	and	titles	as	needed.	Box	plots	are	an	excellent	way	to	visualize	the	spread	of	your	data	and	quickly	identify	outliers.	They	can	be	particularly	useful	in	presentations	or	reports	where	you	need	to	communicate	data	insights	effectively.	Wrapping	Up:	The	Versatility	of	Excel	By	now,	you’ve	got	a	solid	handle	on
calculating	Q1	and	Q3	in	Excel.	From	setting	up	your	sheet	to	calculating	quartiles	using	different	functions,	and	even	visualizing	your	results,	you’re	well-equipped	to	tackle	your	datasets	with	confidence.	Excel’s	versatility	doesn’t	stop	here.	Whether	you’re	working	with	small	datasets	or	large,	complex	ones,	the	skills	you’ve	learned	today	will	serve
you	well.	And	remember,	practice	makes	perfect.	The	more	you	work	with	quartiles,	the	more	intuitive	they’ll	become.	Final	Thoughts	We’ve	covered	a	lot	of	ground,	from	understanding	what	quartiles	are	to	calculating	and	visualizing	them	in	Excel.	These	simple	yet	powerful	tools	can	transform	how	you	analyze	data,	allowing	you	to	make	more
informed	decisions.	Whether	you’re	a	student,	a	business	analyst,	or	just	someone	who	loves	data,	understanding	quartiles	can	be	a	game-changer.	But	what	if	there	was	a	way	to	make	this	process	even	more	seamless?	Enter	Bricks,	a	tool	that	integrates	spreadsheets,	docs,	and	presentations	into	one	cohesive	platform.	With	AI	at	its	core,	Bricks	can
handle	everything	in	your	spreadsheet—from	writing	formulas	and	cleaning	data	to	creating	charts	and	graphics—in	seconds.	You	don’t	need	to	be	a	spreadsheet	expert;	Bricks	AI	does	it	all	for	you,	allowing	you	to	focus	on	what	truly	matters:	making	sense	of	your	data	and	deriving	actionable	insights.	Plus,	Bricks	can	create	stunning	visuals	based	on
your	spreadsheet	data,	such	as	dashboards,	reports,	calendars,	and	more,	all	connected	with	your	docs	and	presentations.	Download	Article	Download	Article	Using	"QUARTILE.INC"	|Using	"QUARTILE.EXC	A	quartile	is	the	name	for	a	percentage	of	data	in	four	parts,	or	quarters,	which	is	especially	helpful	for	marketing,	sales,	and	teachers	scoring
tests.	Do	you	have	data	entered	into	your	Excel	sheet	and	want	to	see	the	quartiles	(like	the	top	25%)?	This	wikiHow	will	teach	you	how	to	calculate	quartiles	in	Excel	using	a	formula.	Select	a	cell	where	you	want	to	display	your	quartile	information.	In	the	formula	box	enter	=QUARTILE.INC(	or	=QUARTILE.EXC(.	Enter	the	range	of	cells	you	want	to
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Don't	add	the	closing	parentheses	because	you'll	need	to	add	more	information	to	the	function.	5	Enter	",1)"	to	finish	the	formula.	The	number	after	the	data	range	can	represent	either	Q1,	Q2,	Q3,	or	Q4,	so	you	can	use	any	number	1-4	in	the	function	instead	of	1.	The	function	QUARTILE.INC(A2:A20,1)	will	show	you	the	first	quartile	(or	25th
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Antonelli,	MA.	Darlene	has	been	writing	and	editing	tech	content	at	wikiHow	since	2019.	She	previously	worked	for	AppleCare,	served	as	a	writing	tutor,	volunteered	in	IT	at	an	animal	rescue,	and	taught	as	an	adjunct	professor	for	EN101	and	EN102.	Darlene	has	completed	Coursera	courses	on	technology,	writing,	and	language.	She	holds	both	a	BA
(2011)	and	an	MA	(2012)	from	Rowan	University	in	Writing,	with	a	focus	on	workplace	communication.	With	her	extensive	experience,	academic	background,	and	ongoing	learning,	Darlene	has	become	the	go-to	grammar	expert	for	her	friends	and	family,	as	well	as	a	skilled	wordsmith	for	anyone	in	need.	This	article	has	been	viewed	90,941	times.	Co-
authors:	3	Updated:	February	24,	2025	Views:	90,941	Categories:	Microsoft	Excel	Print	Send	fan	mail	to	authors	Thanks	to	all	authors	for	creating	a	page	that	has	been	read	90,941	times.	Finding	the	quartiles	for	a	set	of	numbers	helps	us	to	get	a	sense	of	how	the	data	is	spread	out.		Microsoft	Excel	can	find	the	quartiles	(Q1,	Q2,	and	Q3)	for	any	set
of	values	you	choose	as	input.	So,	how	do	you	find	quartiles	in	Excel?		To	find	quartiles	in	Excel,	use	the	QUARTILE	function.	The	inputs	for	this	function	are	an	array	of	cells	(row,	column,	or	block)	and	a	quartile	(1	=	lower	quartile,	2	=	median,	3	=	top	quartile).	For	example,	the	formula	“=QUARTILE(A1:A8,	1)”	gives	the	1st	quartile	of	the	values	in
cells	A1	to	A8.	Of	course,	once	we	find	the	first	and	third	quartiles	(Q1	and	Q3),	we	can	find	the	interquartile	range	(IQR)	by	subtracting	them	(IQR	=	Q3	–	Q1).	In	this	article,	we’ll	talk	about	how	to	find	quartiles	in	Excel.		We’ll	also	look	at	some	examples	to	make	the	concept	clear.	Let’s	get	started.	The	easiest	way	to	find	a	quartile	in	Excel	is	to	use
the	“QUARTILE”	function.		This	function	takes	two	inputs,	separated	by	commas.	The	first	input	is	an	array	of	cells,	which	can	be:	a	row	(for	example,	“A1:J1”	would	be	a	row	consisting	of	10	cells)a	column	(for	example,	“A1:A8”	would	be	a	column	consisting	of	8	cells)a	block	of	cells	(for	example,	“A1:J8”	would	be	a	block	of	cells	consisting	of	8	rows
and	10	columns,	for	a	total	of	8*10	=	80	cells)a	named	range	(for	example	“my_values”,	which	could	denote	any	set	of	cells	you	choose,	including	a	row,	a	column,	or	a	block	of	cells)	The	second	input	is	the	quartile.		This	is	an	integer	(whole	number)	value	between	0	and	4	that	tells	Excel	which	quartile	to	find.	The	quartiles	are	as	follows:	0	gives	the
minimum,	Q0,	of	the	data	set1	gives	the	first	quartile,	Q1,	of	the	data	set	(also	known	as	lower	or	bottom	quartile).		This	is	the	25th	percentile	of	the	data.2	gives	the	second	quartile,	Q2,	of	the	data	set	(also	called	the	median).		This	is	the	50th	percentile	of	the	data.3	gives	the	first	quartile,	Q3,	of	the	data	set	(also	known	as	upper	or	top	quartile).	
This	is	the	75th	percentile	of	the	data.4	gives	the	maximum,	Q4,	of	the	data	set	(You	can	learn	more	about	percentile,	what	it	means,	and	how	to	interpret	it	here).	For	example,	here	are	some	formulas	for	quartiles:	The	minimum	(Q0)	of	the	values	in	cells	A1	to	A8	(a	column	of	8	cells)	would	be	given	by	the	formula	“=QUARTILE(A1:A8,	0)The	first
quartile	(Q1)	of	the	values	in	cells	A1	to	A8	(a	column	of	8	cells)	would	be	given	by	the	formula	“=QUARTILE(A1:A8,	1).		Note	that	the	function	=PERCENTILE(A1:A8,	0.25)	would	also	work,	giving	the	same	result.The	second	quartile	(Q2	or	median)	of	the	values	in	cells	A1	to	A8	(a	column	of	8	cells)	would	be	given	by	the	formula	“=QUARTILE(A1:A8,
2).		Note	that	the	function	=MEDIAN(A1:A8)	would	also	work,	giving	the	same	result.The	third	quartile	(Q3)	of	the	values	in	cells	A1	to	A8	(a	column	of	8	cells)	would	be	given	by	the	formula	“=QUARTILE(A1:A8,	3).		Note	that	the	function	=PERCENTILE(A1:A8,	0.75)	would	also	work,	giving	the	same	result.The	maximum	(Q4)	of	the	values	in	cells	A1
to	A8	(a	column	of	8	cells)	would	be	given	by	the	formula	“=QUARTILE(A1:A8,	4)	You	can	see	an	example	for	Q2	illustrated	below.	The	QUARTILE	function	takes	an	array	of	cells	as	the	first	argument	(this	array	contains	the	data	set)	and	a	quartile	as	the	second	argument	(here,	the	quartile	is	2,	meaning	we	want	Q2,	or	the	second	quartile,	which	is
the	same	as	the	median,	or	50th	percentile,	of	the	data	set).	Here,	Q2	is	31,	since	we	must	average	26	and	36.	To	find	Q1	in	Excel,	we	use	the	QUARTILE	formula	with	two	inputs:	The	first	input	is	the	array	containing	the	values	in	the	data	set.The	second	input	is	1.	So	the	formula	looks	like	this:	where	my_values	is	an	array	(row,	column,	or	block	of
cells).	Note	that	Q1	is	the	median	of	the	bottom	50%	of	the	data	set	(between	the	minimum	and	median,	or	Q0	and	Q2).	Let’s	look	at	an	example	to	see	how	it	works	in	Excel.	Let’s	say	we	want	to	find	the	first	quartile	of	the	data	in	cells	A1:D6	(24	values).	We	would	use	the	formula	You	can	see	this	illustrated	in	Excel	below.	Here,	we	take	the	first
quartile	of	the	data	set	in	the	array	A1:D6.	The	“1”	in	the	second	argument	to	the	QUARTILE	function	tells	Excel	to	return	the	first	quartile,	Q1	(25th	percentile).	In	this	case,	Q1	=	22.	To	find	Q2	in	Excel,	we	use	the	QUARTILE	formula	with	two	inputs:	The	first	input	is	the	array	containing	the	values	in	the	data	set.The	second	input	is	2.	So	the
formula	looks	like	this:	where	my_values	is	an	array	(row,	column,	or	block	of	cells).	Note	that	Q2	is	the	median	of	the	entire	data	set	(between	the	first	and	third	quartiles,	or	Q1	and	Q3).	Let’s	look	at	an	example	to	see	how	it	works	in	Excel.	Let’s	say	we	want	to	find	the	second	quartile	of	the	data	in	cells	A1:D6	(24	values).	We	would	use	the	formula
You	can	see	this	illustrated	in	Excel	below.	Here,	we	take	the	second	quartile	of	the	data	set	in	the	array	A1:D6.	The	“2”	in	the	second	argument	to	the	QUARTILE	function	tells	Excel	to	return	the	second	quartile,	Q2	(50th	percentile).	In	this	case,	Q2	=	44.	To	find	Q3	in	Excel,	we	use	the	QUARTILE	formula	with	two	inputs:	The	first	input	is	the	array
containing	the	values	in	the	data	set.The	second	input	is	3.	So	the	formula	looks	like	this:	where	my_values	is	an	array	(row,	column,	or	block	of	cells).	Note	that	Q3	is	the	median	of	the	upper	half	of	the	data	set	(between	the	median	and	maximum,	or	Q2	and	Q4).	Let’s	look	at	an	example	to	see	how	it	works	in	Excel.	Let’s	say	we	want	to	find	the	third
quartile	of	the	data	in	cells	A1:D6	(24	values).	We	would	use	the	formula	You	can	see	this	illustrated	in	Excel	below.	Here,	we	take	the	third	quartile	of	the	data	set	in	the	array	A1:D6.	The	“3”	in	the	second	argument	to	the	QUARTILE	function	tells	Excel	to	return	the	third	quartile,	Q3	(75th	percentile).	In	this	case,	Q3	=	71.	If	you	want	to	find	out
what	quartile	a	value	is	in,	you	can	use	nested	IF	statements	in	Excel.		You	just	need	to	know	the	values	of	the	three	quartiles	Q1,	Q2,	and	Q3.	For	a	value	in	cell	B2,	the	formula	with	nested	IF	statements	would	look	like	this:	=IF(B2	Module	and	paste	this	code:	Sub	CalculateQuartiles()	Dim	dataRange	As	Range	Set	dataRange	=	Range("A2:A100")	'
Adjust	your	data	range	here	'	Calculate	Q1	Range("B1").Value	=	WorksheetFunction.Quartile_Inc(dataRange,	1)	'	Calculate	Q3	Range("B2").Value	=	WorksheetFunction.Quartile_Inc(dataRange,	3)	End	Sub	After	you’ve	pasted	the	code,	press	Ctrl	+	S	to	save	and	close	the	VBA	editor.	To	run	the	macro,	press	Alt	+	F8,	select	CalculateQuartiles,	and	hit
Run.	This	will	instantly	calculate	Q1	and	Q3	for	you	and	put	the	results	in	cells	B1	and	B2.	How	to	Find	Q1	and	Q3	in	Google	Sheets	In	Google	Sheets,	the	process	is	similar	to	Excel.	Here’s	how	to	do	it:	Option	1:	Using	the	QUARTILE	Function	Google	Sheets	has	a	QUARTILE	function,	just	like	Excel.	Steps:	To	find	Q1,	type	this	formula	in	a	cell	(e.g.,
B1):	=QUARTILE(A2:A100,	1)	To	find	Q3,	type	this	formula	in	another	cell	(e.g.,	B2):	=QUARTILE(A2:A100,	3)	Option	2:	Using	the	PERCENTILE	Function	If	you	prefer,	you	can	use	the	PERCENTILE	function	instead.	Steps:	For	Q1,	enter:	=PERCENTILE(A2:A100,	0.25)	For	Q3,	enter:	=PERCENTILE(A2:A100,	0.75)	Automating	Q1	and	Q3	in	Google
Sheets	Google	Sheets	doesn’t	use	VBA	like	Excel,	but	you	can	still	automate	your	quartile	calculations	with	Google	Apps	Script.	Automating	with	Google	Apps	Script	Follow	these	steps	to	set	up	your	automation:	Open	your	Google	Sheets	document.	Go	to	Extensions	>	Apps	Script.	In	the	script	editor,	paste	this	code:	function	calculateQuartiles()	{	var
sheet	=	SpreadsheetApp.getActiveSpreadsheet().getActiveSheet();	var	dataRange	=	sheet.getRange("A2:A100");	//	Adjust	as	needed	var	data	=	dataRange.getValues();	var	q1	=	percentile(data,	0.25);	var	q3	=	percentile(data,	0.75);	sheet.getRange("B1").setValue(q1);	sheet.getRange("B2").setValue(q3);	}	function	percentile(data,	p)	{	data	=
data.filter(String);	//	Remove	empty	values	data.sort(function(a,	b)	{	return	a	-	b	});	var	index	=	(data.length	-	1)	*	p;	var	lower	=	Math.floor(index);	var	upper	=	Math.ceil(index);	if	(lower	===	upper)	{	return	data[lower];	}	return	data[lower]	*	(upper	-	index)	+	data[upper]	*	(index	-	lower);	}	Save	the	script,	then	go	back	to	your	sheet.	Go	to
Extensions	>	Macros	>	Import	and	select	calculateQuartiles.	Now,	you	can	run	the	calculateQuartiles	function	from	the	Macros	menu,	and	it	will	automatically	calculate	and	fill	in	Q1	and	Q3	in	cells	B1	and	B2.	Wrapping	Up	Whether	you're	using	Excel	or	Google	Sheets,	finding	Q1	and	Q3	is	a	quick	way	to	understand	how	your	data	is	spread	out.
With	the	built-in	QUARTILE	and	PERCENTILE	functions,	it's	easy	to	get	the	values	you	need.	And	if	you're	working	with	large	datasets	or	repeating	calculations,	automating	the	process	with	VBA	in	Excel	or	Google	Apps	Script	in	Sheets	can	save	you	a	ton	of	time.	So	next	time	you	need	to	calculate	quartiles,	you’ve	got	everything	you	need	to	do	it
efficiently!	Steps	Use	the	following	formula	in	cell	E5:	Method	2	–	QUARTILE	Function	to	Find	Quartiles	of	Marks	in	Excel	We	have	some	student	marks.	Our	goal	is	to	find	the	3rd	quartile	of	this	dataset	using	the	QUARTILE	function.	Steps	Use	the	following	formula	in	cell	E5:	Method	3	–	Find	Quartiles	for	All	the	“Quart”	Values	Steps	Use	the
following	formula	in	cell	G5:	The	Cell	reference	in	the	quart	argument.	Press	Enter.	Drag	the	Fill	handle	icon	over	the	range	of	cells	G6:G9.	Method	4	–	Examples	of	QUARTILE.INC	and	QUARTILE.EXC	in	Excel	After	Excel	2007,	Microsoft	substituted	the	QUARTILE	function	two	new	variations:	QUARTILE.INC	and	QUARTILE.	EXC.	The	QUARTILE
function	still	works	in	Excel,	but	it	might	be	rendered	obsolete	and	removed	in	future	versions.	QUARTILE.INC	works	the	same	as	the	QUARTILE	function.	The	“INC”	means	the	function	is	“inclusive”.	This	means	that	QUARTILE.INC	contains	the	minimum	and	maximum	values	when	computing	the	quartiles	in	the	data	range.	We	are	going	to	use	this
in	the	previous	dataset.	Use	the	following	formula	in	cell	G5:	=QUARTILE.INC($C$5:$C$10,E5)	Drag	the	Fill	handle	icon	over	the	range	of	cells	G6:G9.	It	will	show	the	following:	QUARTILE.EXC	excludes	the	minimum	and	maximum	values	while	calculating	the	quartiles	from	the	given	range.	Use	the	following	formula	in	cell	G5:
=QUARTILE.EXC($C$5:$C$10,E5)	Drag	the	Fill	handle	icon	over	the	range	of	cells	G6:G9,	it	will	show	the	following:	Method	5	–	QUARTILE	Function	in	VBA	Steps	Press	Alt+F11	on	your	keyboard	to	open	the	VBA	editor.	Click	on	Insert	>	Module.	Insert	the	following	code:	Sub	quartile_method()			Dim	my_array		Dim	wf	As	WorksheetFunction	
my_array	=	Array(10,	4.7,	13.98,	12,	23.9,	16)		Set	wf	=	Application.WorksheetFunction		MsgBox	wf.Quartile(my_array,	2)		End	Sub		Save	the	file.	Click	on	Run.	It	will	show	you	a	message	box	with	a	result.	Things	to	Remember	✎	The	QUARTILE	function	divides	the	dataset	into	four	equivalent	parts.	✎	It	will	show	a	#NUM!	error	if	the	quart	value	is
less	than	0	or	more	than	4.	✎	If	your	given	array	is	empty,	it	will	also	show	a	#NUM!	error.	✎	It	will	return	a	#VALUE!	error	if	the	given	value	of	quart	is	non-numeric.	Download	the	Practice	Workbook		Uses	of	QUARTILE	Function.xlsm
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